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Want	to	make	your	straight	text	curved	without	much	hassle?	If	so,	Adobe	Photoshop	has	the	exact	feature	you	need.	You	can	use	it	to	curve	your	text	in	your	specified	bend	level,	and	we'll	show	you	how	to	make	use	of	it.	Make	Curved	Text	in	Photoshop	To	curve	text	in	Photoshop,	you	basically	apply	the	warp	text	effect	to	your	text	layer	and	choose
a	curve	option.	For	the	following	steps,	we	assume	you	don't	already	have	an	image	and	you	want	to	create	one	with	your	curved	text	on	it.	To	start,	launch	Photoshop	on	your	computer	and	create	a	new	image.	You	can	do	this	by	selecting	File	>	New	from	Photoshop's	menu	bar	and	choosing	your	image	dimensions.	When	the	blank	image	canvas
opens,	in	Photoshop's	left	sidebar,	select	the	text	tool	(a	"T"	icon).	Alternatively,	you	can	use	the	tool	by	pressing	T	on	your	keyboard.	With	the	text	tool	now	activated,	click	the	area	on	your	image	where	you	want	to	add	the	curved	text.	Type	your	text,	and	when	you're	done,	select	the	checkmark	icon	at	the	top.	In	the	"Layers"	panel	on	the	right,
select	your	newly	created	text	layer.	At	the	top	of	the	Photoshop	interface,	click	"Create	Warped	Text"	(a	"T"	icon).	Photoshop	will	open	a	"Warp	Text"	box.	Here,	click	the	"Style"	drop-down	menu	and	choose	"Arc."	Then	drag	the	"Bend"	slider	to	the	left	or	right	to	make	your	text	curved.	Behind	the	text	box,	you	will	see	your	changes	being	applied	to
your	selected	text.	When	you're	happy	with	the	results,	in	the	same	"Warp	Text"	box,	click	"OK."	Back	on	the	canvas	window,	you	now	have	your	text	curved.	To	change	your	curved	text,	you	can	do	so	without	having	to	re-apply	the	curve	effect.	Simply	click	the	existing	text	and	you	can	add	and	remove	characters	from	it.	And	that's	how	you	make
your	text	stand	out	by	using	a	curved	style.	Very	handy!	If	you	find	yourself	frequently	repeating	the	same	complex	tasks	over	and	over	in	Photoshop,	consider	installing	and	running	Photoshop	actions.	The	mediocrity	of	modern	designs	leads	to	a	search	for	fresh	ideas.	That’s	why	it’s	important	to	create	stunning	designs	that	are	original	and	eye-
catching.	For	such	a	design,	a	feature	such	as	curved	text	is	perfect.	If	you	develop	logos,	icons,	round	stamps	or	creative	text	effects,	you	can	not	do	without	knowing	how	to	curve	text	in	Photoshop.	The	highly	competitive	market	demands	this	essential	skill	for	photo	editing	and	graphic	design.	Therefore,	in	this	Photoshop	guide,	you	will	learn
several	methods	of	text	outlining	and	text	outline	editing	to	create	the	perfect	text	curve	for	your	projects.The	simplest	way	to	curve	text	in	Photoshop	is	by	using	the	Warp	Text	tool:	Open	Photoshop	and	create	a	new	document	or	open	an	existing	one.Select	the	Text	Tool	(T)	from	the	toolbar.Click	on	your	canvas	and	type	your	desired	text.With	the
text	layer	selected,	go	to	Edit	>	Transform	>	Warp	(or	right-click	on	the	text	layer	and	select	“Warp	Text”).From	the	Warp	dropdown	menu	in	the	options	bar,	select	a	text	style:	For	a	simple	arch,	choose	“Arc”For	a	circular	effect,	try	“Arc	Lower”	or	“Arc	Upper”For	a	wave	effect,	select	“Wave”	Use	the	Bend	slider	to	control	the	intensity	of	the
curve.Adjust	the	Horizontal	Distortion	and	Vertical	Distortion	sliders	for	additional	effects.Click	the	checkmark	in	the	options	bar	or	press	Enter	to	apply	the	warp.You	can	always	return	to	edit	text	after	applying	the	warp	by	selecting	the	text	layer	and	accessing	the	warp	options	again.	This	flexibility	makes	it	easy	to	refine	your	text	effect	until	it’s
perfect.For	more	control	over	your	curved	text,	you	can	place	text	along	a	custom	curved	path:	Select	the	Pen	Tool	(P)	or	any	shape	tool	like	the	Ellipse	Tool	(U)	to	function	as	your	path	tool.Draw	the	path	or	shape	you	want	your	text	to	follow.	For	a	circle,	hold	Shift	while	using	the	Ellipse	Tool.Select	the	Text	Tool	(T)	from	the	toolbar.Hover	your
cursor	over	the	path	until	you	see	a	small	curved	line	appear	on	your	cursor.Click	on	the	path	where	you	want	your	text	to	begin	and	type	your	message.To	flip	text	to	the	outside	or	inside	of	a	circle,	go	to	Layer	>	Type	>	Vertical	Type	Orientation.To	adjust	the	starting	position,	use	the	Path	Selection	Tool	(A)	and	drag	the	text	along	the	path.To
change	the	baseline	shift	(how	far	the	text	sits	from	the	path),	highlight	your	text	and	adjust	the	baseline	shift	in	the	Character	panel.Following	this	guide	allows	you	to	precisely	control	the	shape	of	the	text	curve	and	is	particularly	well	suited	for	circular	logos	or	text	that	needs	to	follow	certain	contours	in	a	design.	For	logo	designs	and	stunning
designs	in	general,	keep	curved	text	simple	and	legible	–	excessive	curving	can	reduce	readability.When	creating	circular	text,	use	a	larger	text	size	than	you	might	normally	choose,	as	curving	can	make	text	appear	smaller.Adjust	letter	spacing	(tracking)	in	the	Character	panel	when	curving	text	to	prevent	awkward	gaps	or	overcrowding.For	text
inside	a	circle,	you’ll	often	need	to	reduce	tracking	(letter	spacing),	while	text	outside	a	circle	may	need	increased	tracking.After	creating	curved	text,	you	can	still	edit	text	content	and	formatting	as	needed	–	it	remains	fully	editable	text.Create	a	Smart	Object	of	your	text	layer	before	applying	additional	effects	to	preserve	editability.Consider	adding
a	slight	outer	glow	or	drop	shadow	to	curved	text	to	help	it	stand	out	against	complex	backgrounds.For	more	advanced	text	effects,	try	combining	curved	text	with	layer	styles	like	emboss,	gradient	overlays,	or	stroke	effects.When	working	with	backgrounds	that	make	text	placement	difficult,	consider	using	Generative	Fill	to	create	a	clean	area	for
your	text	to	stand	out.Save	your	curved	text	designs	as	PSD	files	to	preserve	layers	and	editability	for	future	modifications.Other	Photoshop	guides	and	tutorials	on	text	effects	in	various	applications,	as	well	as	photo	editing	techniques	and	typography	techniques	can	be	found	in	the	guides	section.	Also	all	software	that	is	considered	in	these	guides
can	be	downloaded	in	the	section	–	software.To	summarize,	if	you	don’t	master	these	techniques	for	working	with	curved	text,	you’ll	have	a	hard	time	competing	in	our	design	niche,	but	if	you	carefully	study	everything	I	offer	for	training,	you’ll	add	a	powerful	design	element	to	your	toolkit	that	can	beautify	logos,	posters,	social	media	graphics,	and
any	project	that	requires	dynamic	typography.	Experiment	with	different	paths,	warp	settings	and	text	formatting	to	create	truly	unique	curved	text	effects	for	your	projects.	There	are	several	ways	to	curve	text	in	Photoshop.	Some	can	be	achieved	with	a	few	clicks,	while	others	require	more	effort	but	give	you	more	control	over	the	curved	text
created.	Here	are	the	three	best	ways	to	do	it.	Whether	you	want	a	quick	warp	option,	a	customizable	path	method,	or	to	create	circular	text	using	a	circle.	First,	you	need	to	write	any	text	on	the	canvas.	To	do	this,	enable	the	Type	Tool	(T)	in	the	Toolbar.	Then,	enter	the	desired	text	on	the	canvas.	With	the	Type	Tool	active,	go	to	the	Options	Bar	and
click	the	Warp	Tool	button.	Within	the	Warp	Text	panel,	select	one	of	the	arch	styles	available	in	the	Style	drop-down	menu.	To	get	a	curved	text,	it’s	better	to	stick	with	the	first	three	options.	Adjust	the	warp	settings	as	needed	for	the	result	you	want.	Leave	the	Horizontal	option	checked	so	you	can	have	the	text	curved	horizontally.	Control	the
curve’s	prominence	and	orientation	by	adjusting	the	Bend.	Positive	percentages	bend	the	curve	downwards,	and	negative	percentages	bend	it	upwards.	In	Horizontal	Distortion,	you	can	make	the	curve	more	warped	on	its	left	or	right	side.	If	you	want	both	sides	equally	distorted,	set	the	Horizontal	distortion	to	zero.			Adjusting	the	Vertical	Distortion
slider	will	make	the	text	appear	vertically	farther	or	closer	to	the	screen.	Once	you’ve	adjusted	the	settings	to	your	liking,	you	will	have	curved	the	text.	Before	After	First,	enable	the	Pen	Tool	(P)	from	the	Toolbar.	Then,	go	to	the	Options	Bar	and	change	the	pen	mode	to	Path.	After	that,	click	once	on	the	canvas	to	add	the	first	anchor	point.	Then,	click
another	part	of	the	canvas	to	place	the	second	anchor	point,	but	this	time,	hold	Shift	while	dragging	with	the	mouse	down.	That	will	create	a	curved	path.	Once	the	curved	path	is	created,	enable	the	Type	Tool	by	pressing	T.	You	can	also	customize	the	text	using	the	options	available	in	the	Options	Bar	if	you	want.	Now,	hover	over	the	path	until	your
cursor	is	crossed	by	a	curved	line.	Next,	type	any	text	in	the	curved	path.	The	text	in	the	curved	path	has	a	start	and	end	point.	An	X	icon	represents	the	start	point.	The	endpoint	is	represented	by	a	circle	icon.	You	can	change	the	text	start	and	end	points	so	you	can	add	more	text	to	the	path.	To	do	this,	enable	the	Path	Selection	Tool	(A)	from	the
Toolbar.	Then,	hover	over	the	text	until	an	arrow	pointing	to	the	right	appears	next	to	your	text.	Position	the	cursor	at	the	beginning	of	the	text	and	drag	it	to	the	left.	That	will	bring	the	starting	point	to	the	left	and	make	room	for	more	text.	First,	go	to	the	toolbar	and	select	the	Ellipse	Tool	(U)	under	the	Shape	Tools.	Then,	go	to	the	Options	Bar	and
change	the	shape	mode	to	Path.		After	that,	click	and	drag	on	the	canvas	to	create	your	ellipse.	Ensure	the	Fill	and	Stroke	options	are	set	to	Transparent.	Once	the	shape	is	created,	enable	the	Type	Tool	by	pressing	T	on	your	keyboard.	Then,	hover	over	the	shape	until	your	cursor	is	crossed	by	a	curved	line.	Next,	enter	your	text	on	the	curved	path.
You	can	adjust	the	text	start	and	endpoint	following	the	steps	learned	in	the	previous	section	to	change	a	curved	pen	path.	Select	the	text	layer	in	the	Layers	Panel.	Then,	hit	Control	+	T	(Win)	or	Command	+	T	(Mac)	to	enable	the	Transform	Tool.	After	that,	hover	over	one	of	the	handles	around	the	circle	until	it	turns	into	a	double-curved	arrow.
Then,	rotate	the	text	in	the	direction	you	want.	In	my	case,	I	turned	my	text	to	the	center	of	the	canvas.	When	you’re	finished	adjusting	the	text	position,	hit	Enter	on	your	keyboard	to	confirm	the	action,	and	the	text	will	be	ready	to	be	used	in	any	way	you	want.	Curving	text	is	one	of	the	most	popular	ways	to	stylize	text.	It	adds	an	aesthetic	appeal	to
it,	which	is	why	I	often	use	it	in	posters	and	ads,	and	I	also	recommend	you	use	it	whenever	possible.	With	Photoshop’s	customization	options	for	curved	text,	your	result	will	surely	meet	your	expectations.	Happy	Editing!	Photoshop	isn’t	really	intended	as	a	graphic	design	program,	but	there	are	plenty	of	reasons	why	you	might	need	to	create	some
arc	text	in	Photoshop.		Whether	you’re	editing	text	within	a	photo,	creating	text	for	a	photorealistic	digital	art	piece,	or	some	other	reason	I	can’t	even	imagine,	there	are	two	main	ways	to	blend	your	text	in	Photoshop:	warping	your	text	and	placing	your	text	along	a	curved	path.	Both	methods	have	their	advantages	and	disadvantages,	and	they	both
have	very	different	ways	of	creating	curved	text.	Warping	your	text	alters	the	actual	letterforms	themselves	but	creates	some	interesting	shapes	while	typing	along	a	curved	path	maintains	the	original	shape	of	the	letterforms	but	can	also	sometimes	cause	them	to	overlap.	Curving	text	with	either	method	can	negatively	impact	the	readability	and	even
the	legibility	of	your	text,	so	be	sure	to	keep	that	in	mind	when	you’re	working	on	your	edit.	I	think	Method	Two	is	a	better	choice,	but	there	are	probably	some	situations	where	warping	your	text	instead	is	a	better	choice.	Probably.		Method	1:	Warped	Text	This	method	is	probably	the	simpler	of	the	two,	although	they’re	both	very	easy	to	do.		First,
switch	to	the	Text	tool	and	add	some	text.	When	you’re	happy	with	the	content,	locate	the	Create	warped	text	button	in	the	options	panel	above	the	main	image	window	(see	highlighted	area	in	the	screenshot	below).	Click	the	icon	and	Photoshop	will	open	the	Warp	Text	dialog	box.	In	the	Style	dropdown	menu,	you’ll	find	a	wide	range	of	preset	warps
that	can	help	you	create	curved	text.	Perhaps	the	most	useful	warp	preset	is	Arc,	which	creates	a	minimal	amount	of	distortion	in	your	letterforms,	but	you	can	take	your	pick	among	the	options.	I’m	not	sure	why	you’d	ever	want	to	create	warped	text	in	the	shape	of	a	fish,	but	if	you	need	to,	you	can.		Adjust	your	settings	as	desired,	click	the	OK
button,	and	you’re	already	done!	Method	2:	Text	Along	a	Curved	Path	If	you	want	to	create	curved	text	without	actually	distorting	the	letterforms	in	your	text,	you’ll	need	to	create	a	path	first.	Paths	are	actually	vector	objects	that	use	mathematics	instead	of	pixel	dimensions	to	define	their	shapes.	There	are	several	ways	you	can	create	a	curved	path
in	Photoshop,	depending	on	the	kind	of	shape	you	want.	You	can	use	the	Pen	Tool	to	create	freeform	curves	by	placing	anchor	points	and	using	adjustment	handles	to	control	the	angle	of	the	curves,	or	you	can	use	the	Ellipse	Tool	to	create	your	path	instead.			Using	The	Pen	Tool	To	create	a	freeform	curved	path,	switch	to	the	Pen	Tool	using	the
toolbox	or	the	keyboard	shortcut	P.	Click	anywhere	in	your	image	to	set	your	first	anchor	point,	then	click	again	to	create	a	line	between	those	two	points.		Clicking	and	dragging	the	mouse	button	to	create	the	second	point	allows	you	to	create	a	curve	instead	of	a	straight	line,	and	you	can	adjust	the	anchor	points	and	curvature	later	any	time	you
want	using	the	anchor	points	and	curvature	handles.		The	light	blue	line	shows	the	exact	shape	of	the	path,	but	it	won’t	be	visible	in	the	saved	image	Using	the	Ellipse	Tool	Creating	text	along	a	perfect	circle	is	even	easier	using	the	Ellipse	tool.	All	of	Photoshop’s	shape	tools	are	nested	in	the	same	spot	in	the	toolbox,	and	they	all	share	the	keyboard
shortcut	U.	Pressing	the	shortcut	repeatedly	will	cycle	to	the	next	tool	in	the	set.		Before	you	draw	your	ellipse,	it’s	a	good	idea	to	change	the	Fill	and	Stroke	color	settings	in	the	options	panel	to	None	(represented	by	a	white	box	crossed	with	a	red	stripe)	otherwise	you’ll	wind	up	drawing	a	visible	vector	shape	over	your	image	instead	of	an	invisible
vector	path.		The	white	box	crossed	with	a	red	stripe	indicates	that	Photoshop	should	leave	them	empty	If	you	forget	to	do	this	before	drawing	your	shape,	you	can	always	just	remove	the	fill	and	stroke	afterward	in	the	same	location.	You	can	also	modify	these	settings	in	the	Appearance	section	of	the	Properties	panel.	The	Ellipse	tool	can	be	used	in
two	ways:	you	can	click	and	drag	anywhere	in	your	document	to	create	your	ellipse	visually,	or	you	can	click	once	anywhere	in	the	document	to	set	the	size	of	your	ellipse	using	pixel	values.	Setting	equal	values	for	height	and	width	will	create	a	perfectly	circular	path.		Adding	Text	To	Your	Curve	Once	you’ve	created	a	curved	vector	path,	you’re	ready
to	add	text	to	it.	Switch	to	the	Text	tool	using	the	toolbox	or	the	keyboard	shortcut	T,	and	place	your	cursor	over	the	vector	path	in	your	document.	The	cursor	icon	will	change,	indicating	that	you	can	place	text	along	the	path.	Just	click	once	anywhere	on	the	path	to	start	typing	along	it!		(Despite	the	new	screenshot	abilities	of	macOS	Monterey,	I	still
can’t	seem	to	screenshot	the	cursor	change,	but	you	can’t	miss	it!)	The	eagle-eyed	among	you	probably	noticed	that	Photoshop	also	creates	several	text	anchors	along	the	path.	If	you	hold	down	the	Command	key	while	you	click	and	drag	those	anchors,	you	can	adjust	the	placement	of	your	text	within	the	path	itself	(use	Ctrl	instead	of	Command	if
you’re	using	Photoshop	on	a	PC).	A	Final	Word	You	now	know	the	secrets	of	how	to	curve	text	in	Photoshop!	There	are	several	other	techniques	you	could	use,	but	these	two	are	the	only	methods	I	know	of	that	preserve	the	editability	of	your	text.		All	the	other	options	require	you	to	rasterize	your	text	first,	which	permanently	converts	the	letterforms
into	pixel	data	instead	of	editable	vector	text.	Curved	text	is	very	useful	in	graphic	design	projects,	but	as	I	said	in	the	beginning,	Photoshop	isn’t	really	intended	as	a	design	program.	If	you’re	looking	for	even	more	specialized	text	layout	options,	you	might	want	to	consider	using	Adobe	Illustrator	for	your	project.	Do	you	have	a	better	method	for
creating	curved	text	in	Photoshop	that	I	didn’t	mention?	Let	me	know	in	the	comments	below	and	I’ll	try	it	out!	About	Thomas	Boldt	Download	Article	Shape	your	text	into	a	curve	on	Photoshop	with	this	simple	guide	Download	Article	Do	you	want	to	bend,	curve,	or	warp	letters	or	words	on	an	image	in	Adobe	Photoshop?	There	are	several	tools	in
Adobe	Photoshop	that	allow	you	to	add	text	to	a	curved	line,	bend	and	distort	the	text,	and	even	bend	the	letters	themselves.	This	wikiHow	article	teaches	you	how	to	bend,	curve,	and	warp	text	in	Photoshop	with	expert	tips	from	graphic	designer	Shari	Fairclough.	Use	the	Text	Tool	to	add	text,	click	the	Warp	tool	(the	T	over	a	curved	line),	and	use	the
menu	options	to	curve	or	warp	the	text.	Create	a	curved	line	using	the	Pen	or	Ellipse	tool.	Then,	click	the	curved	line	with	the	Text	Tool,	type	your	text	on	the	curve,	and	click	the	checkmark.	Convert	a	text	layer	into	a	smart	object	and	click	Edit	>	Transform	>	Warp.	Click	and	drag	the	Bezier	curve	handles	and	the	grid	points	to	warp	the	text.	1
Select	the	Text	Tool.	To	do	so,	either	press	T	on	your	keyboard	or	click	the	icon	that	resembles	a	“T”	in	the	toolbar.	2	Select	options	for	your	text.	Fairclough	explains	that	to	customize	your	text,	you	can	use	the	drop-down	menus	at	the	top	of	the	Photoshop	window.	Here,	you	can	select	a	font,	style,	alignment,	and	color.	Need	more	fonts?	If	you	have
an	Adobe	Creative	Cloud	subscription,	Fairclough	recommends	checking	out	the	Adobe	Fonts	offered	through	the	Adobe	Creative	Cloud	application.	Advertisement	3	Type	some	text.	To	add	text,	click	where	you	want	to	add	the	text	using	the	Text	Tool	and	type.	Once	you	are	done	typing,	click	the	checkmark	icon	at	the	top	of	the	screen	to	apply	your
text.	4	Click	on	the	Warp	Text	Tool.	It’s	at	the	top	of	the	Photoshop	window.	It	has	an	icon	that	resembles	a	“T”	over	a	curved	line.	Make	sure	your	text	is	still	selected.	If	it	is	not,	click	the	layer	with	your	text	in	the	Layers	panel	to	the	right.	5	Select	a	warp	style.	Use	the	drop-down	menu	next	to	“Style”	to	select	how	you	want	to	warp	the	text.	You	can
create	an	arc,	arch,	bulge,	flag	wave,	twist,	squeeze,	and	more.	6	Select	“Horizontal”	or	“Vertical.”	Click	one	of	the	options	below	the	“Style”	drop-down	menu	to	apply	the	effect	vertically	or	horizontally.	More	often	than	not,	you	will	probably	use	the	Horizontal	option.	7	Adjust	the	bend	of	the	text.	Use	the	slider	bend	below	“Bend”	to	adjust	how
pronounced	the	bend	is.	For	example,	if	you	are	creating	text	in	the	shape	of	a	flag,	the	“Bend”	slider	will	adjust	how	much	the	text	‘waves.’	The	center	of	the	slider	bar	represents	0%	(no	bend).	Dragging	the	slider	to	the	left	of	the	center	of	the	bar	will	cause	the	text	to	bend	in	the	opposite	direction.	8	Adjust	the	distortion	of	the	text.	There	are	two
slider	bars	for	“Horizontal	Distortion”	and	“Vertical	Distortion.”	These	adjust	how	much	the	text	is	allowed	to	skew	along	the	bend.	No	distortion	will	keep	the	letter	shapes	relatively	proportional	along	the	shape	of	the	bend.	Adding	distortion	skews	the	shape	of	the	letters	to	create	a	sort	of	perspective/3D	effect.	9	Click	on	OK	when	you're	finished.
This	applies	the	bend	effect	to	your	text.[1]	Advertisement	1	Create	a	curved	line	to	type	on.	You	can	create	a	curve	using	the	Pen	tool	or	the	Ellipse	tool.	Use	one	of	the	following	steps	to	create	a	path	to	type	on:	Pen	Tool:	Press	P	to	activate	the	Pen	Tool,	or	click	the	icon	that	resembles	a	fountain	pen	tip	in	the	toolbar.	Click	where	you	want	the
curved	line	to	start.	Click	and	hold	where	you	want	the	curved	line	to	end.	While	holding	the	mouse	button,	drag	in	the	opposite	direction	you	want	the	line	to	curve.	This	will	cause	the	line	to	curve..	After	you	release	the	mouse	button,	you	can	adjust	the	curve	by	clicking	and	dragging	the	dots	at	the	end	of	the	straight	lines	(Bezier	curve	handles)
attached	to	the	point	at	the	end	of	the	line.	Ellipse	Tool:	Click	the	Ellipse	tool	in	the	toolbar	(the	shape	tool,	not	the	selection	tool).	Click	and	drag	to	create	an	oval	or	circle	shape	to	type	on.	To	create	a	perfect	circle,	hold	Shift	while	you	drag.	If	you	don’t	see	the	Ellipse	tool	in	the	toolbar,	click	and	hold	the	Rectangle	tool.	Click	the	Ellipse	tool	in	the
pop-out	menu	EXPERT	TIP	Shari	Fairclough	Social	Media	&	Graphic	Design	Expert	Shari	Fairclough	is	a	Social	Media	&	Graphic	Design	Expert	based	in	Atlanta,	Georgia.	Shari	is	a	versatile	designer	with	extensive	experience	in	social	media	marketing,	UX/UI	design,	and	graphic	print	production.	She	has	over	4	years	of	both	freelance	and	in-house
experience	working	as	a	UX	and	Graphic	Designer.	She	currently	works	as	the	Social	Media	&	Marketing	Coordinator	at	Guidepost	Montessori.	In	this	role,	Shari	curates	engaging	content	and	enhances	the	school's	online	presence.	In	2022,	Shari	founded	Sunni	Aesthetics,	a	design	platform	that	blends	culture,	design,	and	art.	Shari	holds	a	Google
UX	Design	certification.	Additionally,	she	studied	graphic	design	at	The	Creative	Circus,	has	four	years	of	experience	working	as	an	assistant	teacher,	and	is	certified	as	a	TEFL	instructor.	Shari	has	contributed	to	various	publications,	including	Canvas	Rebel,	VoyageATL,	and	11	Alive,	and	has	film	credits	on	IMDb	for	her	work	in	"Black	Lightning,"
"The	Color	Purple,"	and	"The	Staircase."	She	received	a	BA	in	Film	&	Media	from	Georgia	State	University.	There	are	things	you	can	do	more	easily	in	Adobe	Illustrator	than	Photoshop.	Illustrator	is	similar	to	Photoshop,	but	it’s	better	for	managing	text	and	vector	graphics.	Try	using	Adobe	Illustrator	to	edit	and	modify	text.	2	Select	the	Text	Tool.	To
do	so,	either	press	T	on	your	keyboard	or	click	the	icon	that	resembles	a	“T”	in	the	toolbar..	On	some	older	versions	of	Photoshop,	you	may	need	to	click	and	hold	on	the	Text	Tool	icon	and	click	Text	on	a	Path.	3	Customize	the	text.	Use	the	drop-down	menus	to	select	the	font,	color,	and	other	options	for	the	text.	If	you	don't	see	a	font	you	want	to	use,
Fairclough	explains	you	can	download	and	install	Adobe	Fonts	through	the	Creative	Cloud	application.	4	Click	the	curve	at	the	point	where	you	want	the	text	to	start.	When	you	hover	over	the	curve	with	the	text	tool,	the	text	cursor	should	change	from	a	“T”	inside	of	a	rectangle	to	a	“T”	over	a	curvy	line.	Click	where	you	want	the	text	to	start.	If	you
are	using	center-aligned	text,	click	in	the	center	of	where	you	want	the	text	to	go.	5	Type	the	text.	As	you	type,	your	text	will	align	with	the	curved	line	you	created.	6	Click	the	checkmark	icon	.	It’s	at	the	top	of	the	Photoshop	window	in	the	center.	This	will	apply	the	text	to	your	image.[2]	If	you	have	a	line	or	ellipse	shape	under	your	text,	you	can
delete	that	layer	in	the	Layers	panel	to	the	right.	Your	text	should	be	on	a	separate	layer.	Advertisement	1	Select	the	Text	Tool.	To	do	so,	either	press	T	on	your	keyboard	or	click	the	icon	that	resembles	a	“T”	in	the	toolbar.	2	Customize	the	text.	Use	the	drop-down	menus	at	the	top	of	the	Photoshop	window	to	select	a	font,	style,	alignment,	and	color.
This	method	works	best	with	large,	bold	text	and/or	multiple	rows	of	text.	3	Type	some	text.	To	add	text,	click	where	you	want	to	add	the	text	using	the	Text	Tool	and	type.	Once	you	are	done	typing,	click	the	checkmark	icon	at	the	top	of	the	screen	to	apply	your	text.	4	Convert	the	text	to	a	smart	object.	To	do	so,	right-click	the	text	layer	in	the	Layers
panel	to	the	right.	Click	Convert	to	Smart	Object	in	the	context	menu.	Once	you	convert	the	text	to	a	smart	object,	you	will	not	be	able	to	edit	the	text.	Make	sure	you	proofread	your	text	first.	5	Open	the	Transform	Tool.	This	will	apply	a	box	with	a	2x3	grid	around	your	text.	Use	the	following	steps	to	open	the	Transform	Warp	Tool.:	Click	Edit	in	the
menu	bar	at	the	top.	Hover	over	Transform.	Click	Warp.	Alternatively,	you	can	click	Skew	or	Perspective	to	try	different	effects.	6	Click	and	drag	the	grid	points	to	adjust	the	curve	and	bend	of	the	text.	You’ll	notice	two	bold	points	on	the	top,	bottom,	and	sides	of	the	box.	Those	are	Bezier	curve	handles.	You	can	click	and	drag	them	to	adjust	the	bend
and	shape	of	the	text.	You	can	also	click	and	drag	the	corners	of	the	box	or	where	the	lines	of	the	grid	intersect.	This	allows	you	to	mold	the	text	into	your	own	unique	shape.	7	Click	the	checkmark	icon	.	It’s	in	the	menu	bar	at	the	top.	This	applies	the	warp	effect	to	your	text.	Advertisement	Add	New	Question	Question	How	do	I	get	the	text	to	be	the
same	size	when	I	use	the	warp	method?	You	have	to	make	the	path	longer	to	fit	the	text.	The	text	won't	go	all	the	way	to	the	end	of	the	path.	It's	a	pretty	clunky	tool.	Ask	a	Question	Advertisement	Co-authored	by:	Social	Media	&	Graphic	Design	Expert	This	article	was	co-authored	by	Shari	Fairclough	and	by	wikiHow	staff	writer,	Travis	Boylls.	Shari
Fairclough	is	a	Social	Media	&	Graphic	Design	Expert	based	in	Atlanta,	Georgia.	Shari	is	a	versatile	designer	with	extensive	experience	in	social	media	marketing,	UX/UI	design,	and	graphic	print	production.	She	has	over	4	years	of	both	freelance	and	in-house	experience	working	as	a	UX	and	Graphic	Designer.	She	currently	works	as	the	Social
Media	&	Marketing	Coordinator	at	Guidepost	Montessori.	In	this	role,	Shari	curates	engaging	content	and	enhances	the	school's	online	presence.	In	2022,	Shari	founded	Sunni	Aesthetics,	a	design	platform	that	blends	culture,	design,	and	art.	Shari	holds	a	Google	UX	Design	certification.	Additionally,	she	studied	graphic	design	at	The	Creative	Circus,
has	four	years	of	experience	working	as	an	assistant	teacher,	and	is	certified	as	a	TEFL	instructor.	Shari	has	contributed	to	various	publications,	including	Canvas	Rebel,	VoyageATL,	and	11	Alive,	and	has	film	credits	on	IMDb	for	her	work	in	"Black	Lightning,"	"The	Color	Purple,"	and	"The	Staircase."	She	received	a	BA	in	Film	&	Media	from	Georgia
State	University.	This	article	has	been	viewed	581,292	times.	Co-authors:	16	Updated:	May	21,	2025	Views:	581,292	Categories:	Adobe	Photoshop	Print	Send	fan	mail	to	authors	Thanks	to	all	authors	for	creating	a	page	that	has	been	read	581,292	times.	"the	tips	provided	are	detailed	and	easy	to	understand.	Thanks	a	lot."	Share	your	story	Curving
text	in	Photoshop	is	easier	than	you	think.	Follow	our	step-by-step	guide	to	learn	how	to	create	and	customize	stunning	curved	text	effects	for	your	designs.	Basics	of	Curving	Text	in	Photoshop	Curving	text	in	Photoshop	can	add	a	unique	and	eye-catching	element	to	your	designs.	Whether	you’re	creating	a	logo,	a	banner,	or	a	social	media	graphic,
curving	text	can	help	make	your	message	stand	out.	In	this	section,	we’ll	cover	the	basics	of	curving	text	in	Photoshop,	including	selecting	the	text	tool,	creating	a	new	text	layer,	choosing	the	desired	font	and	size,	typing	the	text,	and	adjusting	the	text	alignment.	Selecting	the	Text	Tool	To	begin	curving	text	in	Photoshop,	you’ll	first	need	to	select	the
text	tool.	The	text	tool	can	be	found	in	the	left-hand	toolbar,	represented	by	a	large	T	icon.	Simply	click	on	the	T	icon	to	activate	the	text	tool.	Creating	a	New	Text	Layer	Once	you’ve	selected	the	text	tool,	you	can	create	a	new	text	layer	by	clicking	anywhere	on	your	canvas	and	typing	your	desired	text.	Photoshop	will	automatically	create	a	new	text
layer	for	you	to	work	with.	You	can	also	use	the	shortcut	Ctrl	+	Shift	+	N	(Command	+	Shift	+	N	on	a	Mac)	to	create	a	new	text	layer.	Choosing	the	Desired	Font	and	Size	After	creating	a	new	text	layer,	you	can	choose	the	desired	font	and	size	for	your	curved	text.	To	do	this,	simply	select	the	text	layer	in	the	Layers	panel	and	then	click	on	the	font
dropdown	menu	in	the	options	bar	at	the	top	of	the	screen.	Choose	a	font	that	fits	the	style	and	tone	of	your	design,	and	adjust	the	size	to	your	liking.	Typing	the	Text	Once	you’ve	selected	the	font	and	size,	you	can	start	typing	your	text.	Click	on	the	canvas	where	you	want	your	text	to	appear	and	begin	typing.	You	can	also	paste	text	from	an	external
source	if	you	prefer.	Photoshop	allows	you	to	type	and	edit	your	text	just	like	you	would	in	a	word	processing	program.	Adjusting	the	Text	Alignment	To	adjust	the	alignment	of	your	text,	select	the	text	layer	in	the	Layers	panel	and	then	click	on	the	alignment	options	in	the	options	bar.	You	can	choose	to	align	your	text	to	the	left,	right,	center,	or
justify	it.	Experiment	with	different	alignments	to	find	the	one	that	best	suits	your	design.	By	following	these	basic	steps,	you	can	start	curving	text	in	Photoshop	and	create	visually	appealing	designs.	In	the	next	sections,	we’ll	explore	more	advanced	techniques	for	curving	text	using	different	tools	and	effects.	Stay	tuned!	Do	you	want	your	text	to
stand	out?	Try	curving	it	in	Photoshop!	With	just	a	few	simple	steps,	you	can	add	a	unique	touch	to	your	designs.	Let’s	dive	into	the	basics	of	curving	text	in	Photoshop	and	get	started.	To	begin,	select	the	text	tool	by	clicking	on	the	T	icon	in	the	left-hand	toolbar.	This	will	activate	the	text	tool	and	allow	you	to	create	and	text	in	your	design.	Next,	click
anywhere	on	the	canvas	to	create	a	new	text	layer.	You	can	also	use	the	shortcut	Ctrl	+	Shift	+	N	(Command	+	Shift	+	N	on	a	Mac)	to	create	a	new	text	layer.	Once	you’ve	created	a	new	text	layer,	it’s	time	to	choose	the	font	and	size	for	your	text.	Select	the	text	layer	in	the	Layers	panel,	and	then	click	on	the	font	dropdown	menu	in	the	options	bar.
Choose	a	font	that	matches	the	style	and	tone	of	your	design,	and	adjust	the	size	to	your	liking.	With	the	font	and	size	selected,	you	can	now	start	typing	your	text.	Simply	click	on	the	canvas	where	you	want	your	text	to	appear	and	begin	typing.	If	you	have	pre-existing	text	that	you	want	to	use,	you	can	also	copy	and	paste	it	into	your	Photoshop
document.	To	ensure	your	text	is	aligned	properly,	you	can	adjust	the	text	alignment.	Select	the	text	layer	in	the	Layers	panel,	and	then	click	on	the	alignment	options	in	the	options	bar.	You	can	align	your	text	to	the	left,	right,	center,	or	justify	it.	Play	around	with	different	alignments	to	find	the	one	that	suits	your	design	best.	Curving	text	in
Photoshop	doesn’t	have	to	be	complicated.	By	following	these	basic	steps,	you	can	achieve	the	desired	effect	and	make	your	text	stand	out.	In	the	upcoming	sections,	we’ll	explore	more	advanced	techniques	for	curving	text	using	different	tools	and	effects.	So,	let’s	keep	going	and	take	your	designs	to	the	next	level!	Curving	Text	with	the	Warp	Text
Tool	Curving	text	in	Photoshop	can	add	a	unique	and	eye-catching	effect	to	your	designs.	One	of	the	tools	that	can	help	you	achieve	this	is	the	Warp	Text	Tool.	This	powerful	tool	allows	you	to	bend	and	distort	your	text	in	various	ways,	giving	you	the	flexibility	to	create	stunning	curved	text	effects.	In	this	section,	we	will	explore	how	to	use	the	Warp
Text	Tool	and	its	different	features.	Accessing	the	Warp	Text	Tool	To	access	the	Warp	Text	Tool,	you	first	need	to	select	the	text	layer	you	want	to	modify.	This	can	be	done	by	using	the	Text	Tool	(T)	and	clicking	on	the	text	layer	in	the	Layers	panel.	Once	you	have	selected	the	text	layer,	go	to	the	top	menu	and	click	on	“Edit”.	From	the	drop-down
menu,	select	“Transform”	and	then	“Warp”.	Alternatively,	you	can	also	use	the	shortcut	Ctrl+T	(Windows)	or	Command+T	(Mac)	to	access	the	transform	options,	and	then	click	on	the	Warp	Text	icon	in	the	toolbar.	Choosing	a	Warp	Style	After	accessing	the	Warp	Text	Tool,	you	will	see	a	range	of	different	warp	styles	to	choose	from.	These	styles
determine	how	the	text	will	be	curved	and	distorted.	Some	of	the	common	warp	styles	include	Arc,	Arc	Lower,	Arc	Upper,	Bulge,	Shell,	and	Flag.	Each	style	offers	a	unique	way	to	manipulate	the	text.	For	example,	the	Arc	style	creates	a	curved	text	effect,	while	the	Bulge	style	gives	a	bulging	or	swelling	effect.	Adjusting	the	Bend	and	Horizontal
Distortion	Once	you	have	selected	a	warp	style,	you	can	further	customize	the	curved	text	by	adjusting	the	Bend	and	Horizontal	Distortion	options.	The	Bend	option	controls	the	overall	curvature	of	the	text.	By	dragging	the	slider	to	the	right,	you	can	increase	the	bend,	while	dragging	it	to	the	left	reduces	the	bend.	The	Horizontal	Distortion	option
allows	you	to	stretch	or	compress	the	text	horizontally.	Moving	the	slider	to	the	right	stretches	the	text,	while	moving	it	to	the	left	compresses	it.	Modifying	Vertical	Distortion	and	Arc	In	addition	to	bend	and	horizontal	distortion,	you	can	also	modify	the	vertical	distortion	and	arc	of	the	curved	text.	The	Vertical	Distortion	option	controls	the	stretching
or	compression	of	the	text	vertically.	Moving	the	slider	to	the	right	stretches	the	text	vertically,	while	moving	it	to	the	left	compresses	it.	The	Arc	option	adjusts	the	vertical	curvature	of	the	text.	By	dragging	the	slider	to	the	right,	you	can	increase	the	arc,	while	dragging	it	to	the	left	decreases	the	arc.	Applying	the	Changes	Once	you	are	satisfied	with
the	adjustments	you	have	made	to	the	text,	click	on	the	checkmark	icon	in	the	options	bar	or	press	the	Enter	key	to	apply	the	changes.	The	warp	effect	will	be	applied	to	the	text	layer,	creating	the	desired	curved	text	effect.	If	you	want	to	make	further	modifications,	you	can	always	double-click	on	the	text	layer	to	access	the	Warp	Text	options	again
and	make	any	necessary	adjustments.Rapid	Vinyl	-	Design	Your	Own	(Unlimited	Fonts	+	35	Colors	Gloss	&	Matte)	Custom	Vinyl	Lettering	Decal	Sticker,	Auto,	Car,	Window,	Business,	Glass,	Boat,	Truck,	Trailer,	Windshield,	Letters	&	Numbers	Curving	Text	with	the	Pen	Tool	The	Pen	Tool	in	Photoshop	is	a	powerful	tool	that	allows	you	to	create	custom
paths	and	curves.	In	this	section,	we	will	explore	how	to	use	the	Pen	Tool	to	curve	text	in	Photoshop.	By	following	these	steps,	you	can	add	a	unique	and	eye-catching	effect	to	your	designs.	Creating	a	Path	with	the	Pen	Tool	To	begin	curving	text	with	the	Pen	Tool,	you’ll	first	need	to	create	a	path.	Here’s	how:	Select	the	Pen	Tool	from	the	toolbar.	It
looks	like	a	pen	tip.	Click	on	the	canvas	to	create	your	first	anchor	point.	Click	and	drag	to	create	a	curve.	The	direction	and	length	of	the	drag	will	determine	the	shape	of	the	curve.	Continue	clicking	and	dragging	to	create	additional	anchor	points	and	curves	until	you	have	outlined	the	desired	shape	for	your	curved	text.	Converting	the	Path	into	a
Selection	Once	you	have	created	the	path	for	your	curved	text,	you’ll	need	to	convert	it	into	a	selection.	This	will	allow	you	to	add	text	that	follows	the	curve.	Follow	these	steps:	Right-click	on	the	path	you	created	with	the	Pen	Tool.	From	the	dropdown	menu,	select	“Make	Selection.”	In	the	dialog	box	that	appears,	you	can	adjust	the	Feather	Radius	if
desired.	This	can	help	create	a	softer	edge	for	your	curved	text.	Click	“OK”	to	convert	the	path	into	a	selection.	Adding	Text	to	the	Selection	Now	that	you	have	your	curved	path	converted	into	a	selection,	it’s	time	to	add	the	text.	Here’s	how:	Select	the	Text	Tool	from	the	toolbar.	It	looks	like	a	capital	letter	“T.”	Click	inside	the	selection	on	the	canvas
where	you	want	to	add	your	text.	Type	your	desired	text.	As	you	type,	the	text	will	automatically	follow	the	curve	of	the	selection.	Applying	a	Warp	to	the	Text	After	adding	the	text,	you	can	further	customize	the	curve	by	applying	a	warp	effect.	This	will	allow	you	to	fine-tune	the	appearance	of	the	curved	text.	Follow	these	steps:Warp	Bros	CT-12
Cutting	Tool	With	the	text	layer	selected,	go	to	the	top	menu	and	click	on	“Edit.”	From	the	dropdown	menu,	select	“Transform”	and	then	“Warp.”	A	grid	will	appear	over	your	text,	with	handles	that	you	can	manipulate	to	adjust	the	curve.	Click	and	drag	the	handles	to	reshape	the	text	as	desired.	Experiment	with	different	adjustments	to	achieve	the
look	you	want.	Finalizing	the	Curved	Text	Once	you	are	happy	with	the	curve	and	appearance	of	the	text,	it’s	time	to	finalize	it.	Here	are	a	few	steps	to	consider:	Fine-tune	the	positioning	of	the	curved	text	by	clicking	and	dragging	it	within	the	selection.	Adjust	the	font,	font	size,	and	other	text	properties	using	the	options	in	the	top	menu.	Use	layer
styles,	such	as	drop	shadows	or	gradient	fills,	to	enhance	the	visual	impact	of	the	curved	text.	If	needed,	make	any	additional	adjustments	to	the	curve	or	text	until	you	are	satisfied	with	the	final	result.	Curving	text	with	the	Pen	Tool	in	Photoshop	gives	you	the	flexibility	to	create	unique	and	personalized	designs.	By	following	these	steps,	you	can
easily	add	a	curved	text	effect	that	will	make	your	designs	stand	out.	Now,	let’s	move	on	to	the	next	section	to	explore	other	methods	for	curving	text	in	Photoshop.	Customizing	Curved	Text	Effects	Curving	text	in	Photoshop	is	a	great	way	to	add	visual	interest	and	creativity	to	your	designs.	But	why	stop	at	just	curving	the	text?	In	this	section,	we’ll
explore	different	ways	to	take	your	curved	text	to	the	next	level	by	customizing	its	effects.	Let’s	dive	in!	Adding	Drop	Shadows	to	Curved	Text	Adding	drop	shadows	to	curved	text	can	give	it	depth	and	make	it	stand	out	even	more.	With	just	a	few	simple	steps,	you	can	achieve	a	professional	and	polished	look.	To	add	a	drop	shadow	to	your	curved	text,
follow	these	steps:	Select	the	curved	text	layer	in	the	Layers	panel.	Click	on	the	“Layer	Style”	icon	at	the	bottom	of	the	panel	or	go	to	Layer	>	Layer	Style	>	Drop	Shadow.	A	dialog	box	will	appear,	allowing	you	to	customize	the	drop	shadow’s	settings.	Play	around	with	the	options	to	achieve	the	desired	effect.	You	can	adjust	the	opacity,	distance,	and
size	of	the	shadow,	as	well	as	the	angle	and	color.	Once	you’re	satisfied	with	the	look,	click	“OK”	to	apply	the	drop	shadow	to	your	curved	text.	Adding	a	drop	shadow	can	make	your	curved	text	appear	more	three-dimensional	and	give	it	a	professional	touch.	Experiment	with	different	settings	to	find	the	perfect	balance	for	your	design.	Applying
Gradient	Fills	to	Curved	Text	While	solid	colors	can	be	visually	appealing,	using	gradient	fills	can	add	depth	and	dimension	to	your	curved	text.	With	Photoshop’s	powerful	gradient	tool,	you	can	create	stunning	effects	that	will	make	your	text	pop.	To	apply	a	gradient	fill	to	your	curved	text,	follow	these	steps:	Select	the	curved	text	layer	in	the	Layers
panel.	Click	on	the	“Layer	Style”	icon	or	go	to	Layer	>	Layer	Style	>	Gradient	Overlay.	A	dialog	box	will	appear,	allowing	you	to	customize	the	gradient’s	settings.	You	can	choose	from	preset	gradients	or	create	your	own	by	adjusting	the	colors	and	stops.	Play	around	with	the	different	options	to	achieve	the	desired	effect.	You	can	adjust	the	angle,
scale,	and	opacity	of	the	gradient	fill.	Once	you’re	happy	with	the	result,	click	“OK”	to	apply	the	gradient	fill	to	your	curved	text.	Using	gradient	fills	can	give	your	curved	text	a	dynamic	and	eye-catching	appearance.	Whether	you	want	a	subtle	gradient	or	a	bold	and	vibrant	one,	the	possibilities	are	endless.	Using	Layer	Styles	on	Curved	Text	Layer
styles	are	a	powerful	feature	in	Photoshop	that	can	be	applied	to	curved	text	to	enhance	its	appearance.	From	bevels	and	embossing	to	satin	and	inner	glows,	layer	styles	offer	a	wide	range	of	effects	to	choose	from.	To	apply	layer	styles	to	your	curved	text,	follow	these	steps:	Select	the	curved	text	layer	in	the	Layers	panel.	Click	on	the	“Layer	Style”
icon	or	go	to	Layer	>	Layer	Style	and	choose	from	the	available	options.	A	dialog	box	will	appear,	allowing	you	to	customize	the	layer	style’s	settings.	Play	around	with	the	different	options	to	achieve	the	desired	effect.	You	can	adjust	the	bevel	and	emboss	settings,	add	a	satin	effect,	apply	inner	and	outer	glows,	and	much	more.	Once	you’re	satisfied
with	the	result,	click	“OK”	to	apply	the	layer	style	to	your	curved	text.	Layer	styles	offer	endless	possibilities	for	customizing	your	curved	text.	Whether	you	want	to	add	a	metallic	sheen,	a	glassy	effect,	or	a	retro	glow,	layer	styles	can	help	you	achieve	the	desired	look.	Adding	Stroke	and	Outer	Glow	to	Curved	Text	Adding	a	stroke	and	outer	glow	to
your	curved	text	can	make	it	stand	out	even	more	and	give	it	a	polished	finish.	These	effects	can	be	used	together	or	separately	to	create	different	visual	effects.	To	add	a	stroke	and	outer	glow	to	your	curved	text,	follow	these	steps:	Select	the	curved	text	layer	in	the	Layers	panel.	Click	on	the	“Layer	Style”	icon	or	go	to	Layer	>	Layer	Style	and
choose	Stroke	or	Outer	Glow.	A	dialog	box	will	appear,	allowing	you	to	customize	the	stroke	or	outer	glow	settings.	Adjust	the	size,	opacity,	color,	and	other	options	to	achieve	the	desired	effect.	Play	around	with	the	different	settings	to	find	the	perfect	stroke	or	outer	glow	for	your	curved	text.	Once	you’re	happy	with	the	result,	click	“OK”	to	apply	the
stroke	or	outer	glow	to	your	curved	text.	Adding	a	stroke	can	give	your	curved	text	a	defined	outline,	while	an	outer	glow	can	create	a	soft	and	luminous	effect.	Experiment	with	different	settings	to	find	the	perfect	combination	for	your	design.	Experimenting	with	Different	Effects	Now	that	you’ve	learned	some	of	the	basics	of	customizing	curved	text
effects,	it’s	time	to	let	your	creativity	run	wild	and	experiment	with	different	effects.	Photoshop	offers	a	wide	range	of	tools	and	options	that	allow	you	to	push	the	boundaries	and	create	unique	and	eye-catching	designs.	Here	are	a	few	ideas	to	get	you	started:	Try	combining	different	layer	styles	to	create	a	complex	and	layered	effect.	Use	blending
modes	to	blend	your	curved	text	with	other	elements	in	your	design.	Experiment	with	different	fonts	and	sizes	to	find	the	perfect	match	for	your	curved	text.	Play	around	with	the	warp	text	tool	to	create	interesting	shapes	and	distortions.	Apply	filters	and	adjustments	to	your	curved	text	to	create	a	custom	look.	Remember,	the	key	to	finding	the
perfect	effect	is	to	experiment	and	have	fun	with	it.	Don’t	be	afraid	to	try	new	things	and	think	outside	the	box.	Let	your	imagination	be	your	guide	and	create	stunning	curved	text	effects	that	will	impress	and	engage	your	audience.	When	it	comes	to	creating	visually	appealing	designs	in	Photoshop,	curving	text	can	add	a	unique	touch	and	make	your
project	stand	out.	In	this	section,	we	will	explore	the	various	ways	to	and	fine-tune	curved	text	to	achieve	the	desired	results.	Let’s	dive	in!	Modifying	the	Text	Content	Modifying	the	Text	Content	One	of	the	advantages	of	working	with	curved	text	in	Photoshop	is	the	flexibility	it	offers	in	terms	of	editing	the	text	itself.	Whether	you	want	to	make
changes	to	the	wording	or	simply	correct	a	typo,	you	can	easily	modify	the	text	content	without	affecting	its	curvature.	To	modify	the	text	content,	follow	these	simple	steps:	Select	the	text	layer	containing	the	curved	text	by	clicking	on	it	in	the	Layers	panel.	Use	the	Text	tool	to	highlight	the	portion	of	the	text	you	wish	to	edit.	Type	in	your	desired
changes	or	delete	the	existing	text	and	type	in	the	new	content.	Adjust	the	font	size,	style,	or	other	formatting	options	as	needed.	By	being	able	to	modify	the	content	of	your	curved	text,	you	have	the	freedom	to	experiment	with	different	messages	or	make	updates	based	on	client	feedback	without	starting	from	scratch.	This	flexibility	can	save	you
time	and	effort	in	your	design	process.	Adjusting	the	Curvature	of	the	Text	Adjusting	the	Curvature	of	the	Text	Sometimes,	the	curvature	of	the	text	might	not	be	exactly	what	you	envisioned.	Thankfully,	Photoshop	provides	tools	to	fine-tune	and	adjust	the	curvature	of	your	text	to	achieve	the	desired	effect.	To	adjust	the	curvature	of	the	text,	consider
the	following	options:	Select	the	text	layer	with	the	curved	text.	Access	the	Warp	Text	tool	by	clicking	on	the	Edit	menu,	selecting	Transform,	and	then	choosing	Warp	Text.	A	bounding	box	with	control	handles	will	appear	around	the	text.	Click	and	drag	these	handles	to	modify	the	overall	shape	and	curvature	of	the	text.	Experiment	with	different
adjustments	until	you	achieve	the	desired	curvature.	Remember	to	keep	an	eye	on	the	overall	design	and	ensure	that	the	curvature	of	the	text	complements	the	rest	of	your	composition.	Play	around	with	different	adjustments	until	you	find	the	perfect	balance.	Changing	the	Font	or	Font	Size	Changing	the	Font	or	Font	Size	The	choice	of	font	and	font
size	plays	a	crucial	role	in	the	overall	appearance	of	your	curved	text.	Thankfully,	Photoshop	offers	a	wide	range	of	fonts	and	allows	you	to	easily	change	the	font	or	font	size	of	your	curved	text.	To	change	the	font	or	font	size	of	your	curved	text,	follow	these	steps:	Select	the	text	layer	containing	the	curved	text.	Access	the	Character	panel	by	going	to
Window	>	Character.	In	the	Character	panel,	you	can	choose	a	different	font	from	the	dropdown	menu.	Scroll	through	the	options	and	select	the	font	that	best	suits	your	design.	Adjust	the	font	size	using	the	font	size	dropdown	or	by	typing	in	a	specific	size.	Changing	the	font	or	font	size	can	drastically	alter	the	look	and	feel	of	your	curved	text.	It’s	a
great	way	to	experiment	and	find	the	perfect	combination	that	matches	your	overall	design	concept.	Reshaping	the	Path	or	Selection	Reshaping	the	Path	or	Selection	In	some	cases,	you	may	want	to	reshape	the	path	or	selection	that	your	curved	text	follows.	This	can	be	useful	if	you	want	to	create	a	more	intricate	curve	or	if	you	need	to	fit	the	text
into	a	specific	shape	or	object.	To	reshape	the	path	or	selection	of	your	curved	text,	consider	the	following	steps:	Select	the	Path	Selection	or	Direct	Selection	tool	from	the	toolbar.	Click	on	the	path	or	selection	that	your	curved	text	is	following	to	activate	it.	Click	and	drag	the	anchor	points	or	control	handles	to	reshape	the	path	or	selection.	By
reshaping	the	path	or	selection,	you	can	create	more	dynamic	and	customized	curved	text	effects.	This	technique	allows	you	to	integrate	your	text	seamlessly	into	the	design	elements	of	your	project.	Refining	the	Text	Appearance	Refining	the	Text	Appearance	To	create	visually	appealing	curved	text,	it’s	important	to	pay	attention	to	the	finer	details
and	refine	the	text	appearance.	Photoshop	offers	various	tools	and	options	to	help	you	achieve	the	desired	look.	Consider	the	following	tips	to	refine	the	appearance	of	your	curved	text:	Experiment	with	different	effects	such	as	drop	shadows,	gradient	fills,	layer	styles,	stroke,	and	outer	glow.	These	effects	can	add	depth	and	dimension	to	your	curved
text.	Play	around	with	different	blending	modes	to	blend	the	curved	text	with	the	background	or	other	design	elements.	Adjust	the	opacity	of	the	text	layer	to	control	its	transparency	and	create	subtle	or	bold	effects.	Consider	using	layer	masks	to	selectively	hide	or	reveal	parts	of	the	curved	text,	allowing	for	more	creative	compositions.	By	refining
the	appearance	of	your	curved	text,	you	can	elevate	your	design	and	create	visually	captivating	compositions	that	engage	the	viewer.	Exporting	and	Saving	Curved	Text	Curving	text	in	Photoshop	can	add	a	unique	touch	to	your	designs,	and	once	you’ve	created	the	perfect	curved	text,	it’s	important	to	know	how	to	export	and	save	it.	In	this	section,
we’ll	explore	different	ways	to	save	your	curved	text,	whether	as	a	Photoshop	file,	an	image	file,	or	for	web	or	print	purposes.	We’ll	also	discuss	the	importance	of	considering	file	formats	and	resolutions,	as	well	as	how	to	share	and	use	your	curved	text	effectively.	Saving	the	Curved	Text	as	a	Photoshop	File	When	you’ve	finished	curving	your	text	and
you	want	to	preserve	all	the	layers	and	editable	elements,	saving	it	as	a	Photoshop	file	is	the	way	to	go.	By	saving	it	in	this	format,	you’ll	be	able	to	make	further	edits	and	adjustments	to	the	curved	text	in	the	future.	To	save	your	curved	text	as	a	Photoshop	file,	follow	these	steps:	Make	sure	you	have	the	curved	text	layer	selected	in	the	Layers	panel.
Go	to	the	“File”	menu	and	select	“Save	As”	or	use	the	shortcut	“Ctrl	+	Shift	+	S”.	Choose	a	location	on	your	computer	where	you	want	to	save	the	file.	In	the	“Format”	dropdown	menu,	select	“Photoshop”	or	“.PSD”.	Give	your	file	a	name	and	click	“Save”.	By	saving	your	curved	text	as	a	Photoshop	file,	you	can	easily	access	and	modify	it	whenever	you
need	to	make	changes	or	use	it	in	different	projects.	Exporting	the	Curved	Text	as	an	Image	File	If	you’re	looking	to	use	your	curved	text	outside	of	Photoshop,	such	as	in	a	presentation	or	on	a	website,	exporting	it	as	an	image	file	is	a	convenient	option.	This	allows	you	to	share	the	curved	text	in	a	format	that	can	be	easily	opened	and	viewed	by
others.	To	export	your	curved	text	as	an	image	file,	follow	these	steps:	Ensure	that	the	curved	text	layer	is	selected	in	the	Layers	panel.	Go	to	the	“File”	menu	and	choose	“Export”	or	use	the	shortcut	“Ctrl	+	Shift	+	Alt	+	S”.	Select	the	desired	image	format,	such	as	JPEG,	PNG,	or	GIF.	Choose	a	location	on	your	computer	to	save	the	image	file.	Provide
a	name	for	the	image	file	and	click	“Save”.	Exporting	your	curved	text	as	an	image	file	allows	you	to	share	it	across	various	platforms	and	applications	without	the	need	for	Photoshop.	Saving	the	Curved	Text	for	Web	or	Print	Whether	you’re	designing	for	the	web	or	print,	it’s	important	to	save	your	curved	text	in	the	appropriate	format.	This	ensures
that	your	text	appears	crisp	and	clear,	without	any	loss	of	quality.	When	saving	for	web	or	print,	consider	the	following	tips:	For	web	use:	Save	your	curved	text	as	a	JPEG	or	PNG	file.	JPEG	files	are	ideal	for	photographs	or	complex	images,	while	PNG	files	are	better	for	graphics	with	transparency.	For	print	use:	Save	your	curved	text	as	a	high-
resolution	image	file,	such	as	TIFF	or	EPS.	These	formats	retain	the	highest	quality	and	are	suitable	for	professional	printing.	Remember	to	adjust	the	image	resolution	according	to	the	intended	use.	Higher	resolutions	are	necessary	for	print,	while	lower	resolutions	work	well	for	web	display.	Considering	File	Formats	and	Resolutions	When	exporting
or	saving	your	curved	text,	it’s	essential	to	consider	the	file	format	and	resolution	that	best	suits	your	needs.	Different	file	formats	have	varying	levels	of	compression	and	support	different	features,	while	resolutions	determine	the	clarity	and	detail	of	your	curved	text.	Here	are	some	popular	file	formats	and	resolutions	to	consider:	File	formats:	JPEG,
PNG,	TIFF,	EPS,	PDF	Resolutions:	72	DPI	(web),	300	DPI	(print)	Choosing	the	appropriate	file	format	and	resolution	ensures	that	your	curved	text	looks	its	best	in	any	context,	whether	it’s	on	a	website	or	in	a	printed	document.	Sharing	and	Using	the	Curved	Text	Once	you’ve	exported	or	saved	your	curved	text,	it’s	time	to	share	and	use	it	in	your
projects.	Consider	the	following	tips	to	make	the	most	of	your	curved	text:	Share	on	social	media:	Post	your	curved	text	on	platforms	like	Instagram,	Facebook,	or	Twitter	to	showcase	your	design	skills	or	promote	your	brand.	Use	in	presentations:	Incorporate	your	curved	text	into	PowerPoint	or	Keynote	presentations	to	add	visual	interest	and	engage
your	audience.	Apply	to	graphics:	Overlay	your	curved	text	onto	images	or	graphics	to	create	eye-catching	visuals	for	blog	posts,	flyers,	or	advertisements.	Incorporate	into	websites:	Use	your	curved	text	as	a	logo,	header,	or	decorative	element	on	your	website	to	give	it	a	unique	and	personalized	touch.	By	sharing	and	using	your	curved	text
creatively,	you	can	make	a	lasting	impression	and	elevate	your	designs	to	new	heights.	In	conclusion,	exporting	and	saving	curved	text	in	Photoshop	allows	you	to	preserve	your	design,	share	it	with	others,	and	use	it	in	various	projects.	Whether	you	save	it	as	a	Photoshop	file	for	future	edits	or	export	it	as	an	image	file	for	web	or	print,	considering	the
file	formats,	resolutions,	and	sharing	options	will	help	you	make	the	most	of	your	curved	text.	So	go	ahead	and	experiment	with	different	effects,	customize	your	curved	text	to	fit	your	style,	and	let	your	creativity	shine.


